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Herbersteinstr. 60, 8020 Graz, Austria, guger@gqtec.at

This tutorial shows HOW-TO find and extract proper signal features from EEG data to separate
epochs of EEG into distinct classes. The outcome is a classifier which can be used in real-time Brain-
Computer-Interface experiments.

What is Brain-Computer-Interface?

An Electroencephalogram based Brain-Computer-Interface (BCl) provides a new communication
channel between the human brain and a computer. Patients who suffer from severe motor
impairments (late stage of Amyothrophic Lateral Sclerosis (ALS), severe cerebral palsy, head trauma
and spinal injuries) may use such a BCl system as an alternative form of communication by mental
activity.

Physiological background

It is a well known phenomenon that EEG rhythmic activities, observed over motor and related areas of
the brain, disappear about 1 second prior to a movement onset. Hence one can predict from the
spatio-temporal EEG pattern that, for example, a hand movement will be performed. It has also been
shown by various groups of researchers that this so-called desynchronized EEG is also observed for
an imagination of a hand movement.

The activation of hand area neurons either by the preparation for a real hand movement or by
imagination of a hand movement is accompanied by a circumscribed ERD over the hand area.
Depending on the type of motor imagery different EEG patterns can be obtained. Hence, one finds
also a circumscribed ERD over the foot area in foot movement and foot imagination experiments.

Experimental paradigm and recording setup for the BCI data acquisition
Experimental paradigm

The data set used for classification was acquired during a brain-computer interface experiment with
feedback. The session was divided into 4 experimental runs of 40 trials with randomized directions of
the cues (20 down and 20 right) and lasted about 1 hour (including electrode application, breaks
between runs and experimental preparation). The subject sat in a comfortable armchair 1.5 meters in
front of a computer-monitor and was instructed not to move, keep both arms and hands relaxed and to
maintain the fixation at the center of the monitor throughout the experiment.
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Figure 1: Timing of one trial of the

! ] fixation cross experiment with feedback.
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The experimental paradigm started with the display of a fixation cross that was shown in the center of
a monitor. After two seconds a warning stimulus was given in form of a "beep". From second 3 until
4.25 an arrow (cue stimulus), pointing down or to the right was shown on the monitor. The subject was
instructed to imagine a foot or right hand movement depending on the direction of the arrow. Between
second 4.25 and 8, the EEG was classified on-line and the classification result was translated into a
feedback stimulus in form of a horizontal bar that appeared in the center of the monitor. If the person
imagined a right movement the bar, varying in length, extended to the right and vice versa (correct
classification assumed). The subject's task was to extend the bar toward the bottom or right boundary
of the monitor as indicated by the arrow cue. One trial lasted 8 seconds and the time between two
trials was randomized in a range of 0.5 to 2.5 seconds to avoid adaptation (see figure 1 for the timing
of the paradigm).

EEG recording
Two bipolar recordings overlaying the left and central sensorimotor area were placed on the subject's
head as indicated in figure 2. The ground electrode was attached to the forehead.
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The amplified EEG was band pass filtered by an analog filter between 0.5 and 30 Hz and sampled at
128 Hz. The resolution was 12 bits. A notch filter was used to suppress the 50 Hz power line
interference.
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1. Data Inspection

Running g.BSanalyze

1. After starting MATLAB set the current directory to
"MATLAB directory\gtec\gBSanal yze\testdata\bci” and start "gBSanal yze”
in the MATLAB command line.

Dame _Ioix]

File Edit Yiew Web Window Help

Der| & B2 W« cx “ l ? | Current Directory: IC:NATLABBpS'l.glec\gBSanalyze'testdata\BCI Ll
>>» gbsanalyze a

1 He
45tarl|

2. g.BSanalyze starts with a blank data window

L8[

File Help

=15 2] 5] 2| o -

Mﬂl Fe [Hz]'l time: [s]'l samples'l trials'l channels'l | J
1| | >| Gato second. I Chaninel I Triak
DISPLAY PRESENT SHOW MARKERS A ATTH. EPDCHING T00LS COMMENT FILE
:.' Seconds Ichannel whial ¥ [V Chan. attr. [ Yert scale Select... Edit | " Free mode Select datal Analize .. I Mew I Save presets I
:.' Channels Iposlt\ve seale ¥ | ¥ Trialatt,. ¥ Hor. scale r Ruler |
— — hone I:l Multi chan. Create plot |
=1 Trials Zoom |1DD =i | ¥ Separators ¥ Grid
Select ... I UndUl Aut”Ma Aml T_l,lpl ¥ Markers [V Ch. name Cancel | £ pulti trial Open journal |
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Loading and Viewing Data

1. Select Load Data in the File menu
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2. Open the data-set by selecting session1.mat from the directory

"Your

MATLAB di rect ory\ gt ec\ gBSanal yze\t est dat a\ bci ”

3. Enter a sampling frequency of 128 Hz in the Enter Sampling Frequency window

4. Press OK and the data are displayed

) Data Editor 1= x|
File Help
L Jata [}
Load Class Infarmmakio
Load Headzr InFDrmaq
Save M5 Load Data 2=l
SEVE 85 = :
Suchen in: |ﬁ BCI j = = EE-
Impork
Export : class160.mat
£ class40.mat
Page Position sessionl.mak
Page Setup ] sessionz, mat | |
R (= P lsessionz.mat [ ryn: MATLAR data file
Frint $. ) sessiond.mat | Grafe: 1,02 MB
Close all Figures
Exit
Dateiname: Isesswon‘l mat Offrien I
Diateityp: [AIMAT Files [mat) =l ahbrechen
-} Enter Sampling Frequency: x|
Pleaze enter the sampling frequency that was used to acquire the
data
DAQ-Setting: 3—-
’7 Sampling rate [Hz} 128
OK!
ﬂil Fs [Hz]:l tirne [s]:l samples:l trials: I channels:l | =l
1 | | >| Goto second: I Channel: Trial:
DISPLEY | FRESEMNT | SHOW | MARKERS fATTR. | EPOCHING | TOOLS | CommeNT | FILE
:.'I Seconds Ichannelxtlial Jladl [¥ Chan. attr. [ Vert. scale Select. | Edif | " Free mode Select dalal Analize ... I New I Save presets I
:.'I Channels Iposilive scale 7| | W Thalatr. [ Hor scde I— l:‘ £ Multi chan Ruler Create plat
— . nane 1eate plol |
2 Tiials Zoom I'IDD 21 | ¥ Sepastors [ Grid 2
¥ Markers ¥ Ch name ezl | £ bult trial

Select |m| MIE ﬂlﬂl

Open jourmnal |
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-} Data Editor: C:\MATLABEp5S gtecgB5analyze' testdata'BCI'sessionl.mak == x|
File Header View Tramsform Pre-Processing Tools Artifact  Analyze Parameter_Extraction Classification  Options Help  User

-
=|H| 8|22 2] =

CH1

A1 380y

22 352p Ho - 1 b '.T‘ I

Ci3 3 4Bl | | oo | SRR | [ S b L, |

41.0 420 430 44.0 45.0 46.0 470 48.0 43.0

EI F) [HZ]ZI 128 time [S]ZI 42914 samples I 44661 trigls: I 1 channels:l 3 | =
4 I/N\ PI Golo second: 40 Channel: I 1 Trial: I 1
DISPLAY | PRESENT | SHOW | MAREERS /ATTR. | EPOCHING | TOOLS | COMMENT | FILE |

:l'l Seconds Ichannelxtrial | | ¥ Chan. attr. [ ‘et scale Select... I Edit % Fiee mode Select datal Analize ... I New I Save presets I
=1 Channels IDDSI“VE scale T ¥ Tialat. [ Hor. scale l— Ruler |
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=3 Trise Zoom  [100 = | ¥ Separstors ) Giid reate plo |

ﬂl ﬂ”Ma ﬂlﬁl ¥ Markers W Ch name &I £ Fulti trial Open joumal |

In the display section you can set the number of Seconds/Channels/Trials that should be displayed
on the screen. Select 10 Seconds for the number of seconds on the screen and Goto second 40.
Press on button S> for the status information. In this case the status information gives you a sampling
frequency of 128 Hz, the total recording time of about 348.9141 seconds with 44661 data samples.
The current data set has 1 trial and 3 channels (CH1, CH2 and the trigger TRG).



medical & electrical engineering g .

GUGER
TECHNOLOGIES

Channel configuration

1. Select Channel Configuration in the Header menu

2. Assign Name C3 to Chan. number 1 and choose Channeltype EEG
Assign Name Cz to Chan. number 2 and choose Channeltype EEG
Assign Name TRGto Chan. number 3 and choose Channeltype TRG

) Data Editor: C:\MATLABGpS Otect, gBSanalyze' testdata’BCI' sessionl.mat _|ﬁ' ll
File Header View Transform Pre-Processing Tools  Artifack  Analvee  Parameter_Extraction Classification  Options  Help  User
& o Al
Amplifier
ki -} Channel Configuration o (=] 3 1
alibration |
5 q Use this window to inspect and edit your channel configuration. Mote that you can use the function *'Load header |
SEXER information' to get header information from an existing file. To load an electrode configuration created with the |
- Marker o.MOMcreator use the Browse button, 3
T e — CONFIGURATION: WWWWW
Session/Paradigm Total number of channels: I 3 Montage Creatar name: I Browse
Camparty
L .~ SETTNGS —o— [ |
E Chan. number: Mame: Channeltype: Chan. number: Mame: Channeltype: 3
: 1 C3 EEG | N5, | '
2 Cz EEG | N5 |
22 a2y 3 TRG M.5. | N.5. I~ A
N.S. I~ '
NS [ |
NS |
NS I I N
NS. =l :
NS 7] 3
H.5. | N.S. I~
NS, - NS, - ;
©:3 3 481p S — S e T S —
H.5. I~ N.3. = :
W5 I N5 I~
N5, 4 NS, 4 |
M. = N = |
4.0 N.S. = N.S. = 40,0
L5 rspat [ 128 timel P Curentpage: [T of[ 1 > =
4 | 0 Chaninel I 1 Triak 1
Dlsiljw | O MASTER: | COMMENT | FILE |
10 =i Seconds char Chan. number: Name: Channeltype: J Mew I Save presets I
= -
3
_‘—: Clhamrels ;wt Stark at channe\:l end at: I Apply -> I auta I M.5. e Create plat |
= Trials ‘aor
Select ... | Undo| | Aut Open journal |
Unde] | [ Haln | cancal | ok |

3. Pressing OK yields

File Header WView Transform Pre-Processing Tools Artfact A

=W 8| 2| p| 0|2

cd 3 350y

2z €z 352p

C:3 TRG 48.1
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2. Merge Data

A total of 4 so called runs were recorded and stored to disk under filenames sessi onl. mat ,

sessi on2. mat, session3. mat and sessi on4. mat . Merging the 4 data sets together yields to
160 (80 left hand and 80 foot) movement imaginations. For the further analysis of the data a
concatenation of all runs is necessary.

Perform the following steps:
1. Select Merge in the menu Transform

2. Press Select files ... and choose sessi on2. mat

J Merge _I_I- m| 5'

. kerge tialz, channels or zamples of multiple data-zets.

— Files to MERGE:

Filename / Dim. [TRIALS = SAMPLES » CHANMELS]

Select files __. |
Remove |

[

Dim. [TRIALS » SAMPLES x CHAMMELS)

Dutput preview: I [1=176841 231
Concatenate: = TRIALS Adopt: ¥ Channel attributes
i SAMPLES I Trial attributes
" CHAMWMELS v tdarkers

Help Cancel OK!
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3. Enter a sampling frequency of 128 Hz in the Enter Sampling Frequency window

4. Repeat Steps 3 and Step 4 also for sessi on3. mat and sessi on4. mat

5. Select Concatenate SAMPLES. Output preview shows the expected result of the
merging process. Press the button OK.

The new data-set consists now of 3 channels, 1 trial and about 4 times more samples as a single data-
set (176841 samples).

See Status under the View menu.

EI Fsz [Hz]:l 128 time [s]:l 1381.5703 samples:l 176841 trials:l 1 channels:l 3 |
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3. Trigger Data

For many calculations performed with biosignal data an epoching or triggering of data-sets is
necessary. Therefore, a specific time marker or trigger channel with special events is required. The
current data set has 160 TTL-trigger impulses on channel 3 which can be used to split the data into
trials of equal length.

1. Select Trigger in the Transform menu
2. Define the Time before trigger as 2000 ms and Time after trigger as 6000 ms

3. Select channel 3 in Physical channel as trigger channel and set the Threshold level to 90 % of
maximum

4. Select e.g. the name TRI GGER in Assign attribute to resulting trials and press button
add to list ->

5. Press Start! to perform the triggering

) Data Editor: C:\MATLABGpS Otect, gBSanalyze' testdata’BCI' sessionl.mat - |ﬁ' ll
File Header View Transform Pre-Processing Tools  Artifack  Analvee  Parameter_Extraction Classification  Options  Help  User
= & P L cutSamples =
= (Ut Trials Channels Chrl+C ) Trigger =101
——  Sork Trials Channels . . . . . . . . . .
! The trigger function splits vour recorded data inta trials related to trigger imepoints defined by physical
Arithmetic ' channels or markers. The use of diigeent markers ar channels allows to assign attibutes automatically to
resulting trials. Channel attributes arkers remain in the triggered data.
Merge Chrl+M '
: — Specify TRIAL FPARAMETERS:
" I
C1C3 500p Mm[ﬂ Un:rlggelr o ﬂlbfhw Time before trigger: 2000 [ms) Time after krigger 5000 [msz] I~ Accept incomplete
E ' ' 256 [samples] TEE [samples] last tnal

— Specity TRIGGERS and ATTRIBUTES

L e i R, 4: R, 4: - &+ Physical channel: [C3CH1) ;l Edge: Insing j # Threshold valtage: 4333 1]
i i ; Cz(CH2 <  Theshold level: 0 [%efman]
: : :  Slew rate: 569 |
(o . [ ~ -
Marker BEGIN Chan. [Marker)/ Mame/ Edge/ Value/ Attributes Overlap/ Calor

C:2 Cz S00p

Ch . GGEER/ hot red

4.

Assign attribute o resulting trials: TRIGGER

I~ Accent overlap

<- remove from list
apply changes -

Change color:

= = | o] ]
C:3 TRG 481 pf==ococaco-e--. """"""" """"""" nlangel olive LI

— Generate LINED UP TRIALS:

E i i " Line up trials [no igger) Length of trials: 1000 [mg] Owerlap: i} [ms]
1 1 1
1.0 420 430 128 [samples] i [samples]
o) 5<| FeHap| 128 timels)| 13815703 les:| 17684 ) ; =
‘J_I st | =0 samles| — Select CHANMNELS for the triggered file: |_1_1
DISPLAY PRESENT SHTw Select channels ... | £
10 :.'I Seconds Ichannelxtnal 1 | ¥ Chan attr. [+ p— |
3 :." Channels |positwe scale  w| | WV Tralatr, [V Help ‘ Cancel | Start | |
= o ad = plot I
1 =i Trals Zoom 100 35 | ¥ Separatars [V

The status bar in the editor windows shows the result: the number of trials is 160 and one trial has a
length of 1024 samples.

il Fz[Hz]: I 128 tirne [z]: I 8 samples: I 1024 brials: | 160 chanmnels: I 3 |
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g.BSanalyze allows to assign channel attributes and trial attributes which are used for further
calculations to include or exclude specific trials or channels. Trials with EOG, EMG or overflow
artifacts can be marked with the trial attribute ARTIFACT to be excluded from further processing or
with the attribute REMOVE to be deleted. Also channels, which are not relevant for further processing
such as the trigger signal after triggering or channels with noise, can be marked with BAD to be
excluded. On the other hand it is also possible to assign a trial attribute like RIGHT to indicate a right
hand movement and to include only trials with the RIGHT attribute in further calculations.

To assign attributes perform the following steps:

1. Press Select in section MARKERS/ATTR.

2. Click on Edit CHANNEL ATTRIBUTE and enter TRIGGER under Create new. Press the button
Add to list. Click on button purple to assign a new color

J Edit markers and attributes

X

Chooze a marker, channel attribute ar trial attibute you wizh to edit or add a new one. Press ‘0K and uze the
mouze to azsign markers or bo aszign attibutes. Markers and attnbute colors will be azsigned to the data in the
Drata Editar. If a trial or channel has mare than one attribute the seament appears in blue.

" Edit MARKER

JeEGINsed [l

EMD Ablue

=
Create new: I

il b1t | Eemowe |

" Edit TRIAL ATTRIBUTE

REMOVE fblue
TRIGGER /red

=
Create new: I

il b1t | Eemowe |

& Edit CHANMEL ATTRIBUTE

Bal fred -
CUT /blue _I
TRIGGER /pu.

=
Create new: I TRIGGER

Add to list | Remove |

Change COLOR tar

o] | [ ]

Cancal | 0K |

3. Close the window with OK!
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Assign the attribute TRI GGER to channel 3 by clicking onto the line that represents channel 3. The
attribute TRI GGER is indicated at the left border of the window.

€2 Cz 5000 - phgd-lpg-o-- : ' ; ;
C:3TRG 484 pfomeneeneeneeeeidn e S R
TRIGGER E E E E
i i i i
1.0 2.0 3.0 4.0
ﬂﬂl Fs [Hz]:l 128 time [s]:l 8 samples:| 1024 ials:| 160 channels:l_
il
DISPLAY FRESEMT SHOW MARKERS # ATTH.
g ﬁ Seconds channel » trial j [+ Chan. attr. W Yert scale Select. .. | I E dit
3 =1 Channelz | |positive scale j ¥ Tiialatt. v Hor. scale T .
1 =1 Trialks Zoom Ii':":' = | ¥ Separators v Grid
Select ... | LIr'u:Iu:uI ,-i'-.utl Mal -ﬁ-mllT}'p IV Makers W Ch. name Cancel |
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5. Load Class Information

The Load Class Information window is used to assign trial attributes to the data from a given *. mat ,
or ASClII-file. The loaded class information vector must match the number of trials. Assume that you
have loaded a data file with 3 trials into g.BSanalyze. An appropriate class information vector would be
0 1 0. Load class information would assign an attribute to the second trial.

1. Select Load Class Information from the File menu

2. Click on the Import Wizard

3. Search for the class information file cl ass160. nmat in the same directory. The Import Wizard
shows the variables stored in the file and gives a truncated preview of the class information.

) Data Editor: C:\MATLABGpS Otect, gBSanalyze' testdata’BCI' sessionl.mat - |ﬁ' ll
File Header View Transform Pre-Processing Tools  Artifack  Analvee  Parameter_Extraction Classification  Options  Help  User

Load Data Chrbes L]

Load Class Information

Load Header Information T I T

Save Chrls -} Load Class Information ] |
Save as...

This function assigne trial attributes [class information) from a given * mat or
Import 4 ASCII-file ta tials of pour data. The class information vectar must match the

Export 3 number of trials! i : i AP : _____

Page Pation — Selecta CLASS INFORMATION FILE:

Page Setup Browise ... | Import Wizard |
X
Prink —I—I -

— Define ATTRIBUTES o~ _a
Suchen in: |@BEI j = £ ER-

class160.mak
n class40.mal
#)sessionl.m{ Typ: MATLAE data File u m}g
sassionZ.m Griifie; 504 Byte

n sessions.mat
n sessiond.mat

Close all Figures
e T
| Change name to: I

Azsign Attibute
Remove Attribute

C:2 Cz S00p

B - Tmport Wizard: C:ATLABGDS  gtec /aBSanalyze testdat a/BOL class 1608k \=10]x]
Datein SeE01 VBrianies 10 IMPor USINg enecknnxas.
& Crealey
Dateity c“'e ."_".m“."' e
: C oo
C:33 TRG 4384 p e ;
TRIGGER : Help Cancel | e lac MaT
' | VaisblaName 220 | owel] cise Pranfew fruncatad 1o 10:10
| 2 3 | a4
1 [ q 0
1 | 1 | 3 1 1 1
| | | | |
10 20 30 40 | 4
Js| 5¢ s g . . el I -
J_I Fs [Hz].l 128 timne [s].l 8 samples.l 1024 tnals.l 160 channels: d
<l B
DISPLAY | FRESENT | SHOW | MARKERS /ATTF. £
o
a [ harrel wtial ¥ [ Ed i S~
: Seconds IC a.nne whial - ¥ | [ Chan attr. [ Wert scale Select... Edit _IJ
3 =i Channels Iposltwe seale v | W Tralatt,. [ Hor scale Cancel | = Batk 1 e Finlsh u
o = GEECI |
1 =i Trials Zoom I'IEIEI =1 | ¥ Separators v Grid |
Select ... | Undol Autl Ma Am”Typ I Markers [ Ch. name Cancel | £l Open journal |

4. Click Finish to assign the attributes to the data trials. The window shows the attribute name 4 for
the first row of the loaded class matrix and 5 for the second row.
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5. Select the new-loaded attribute 4, enter the attribute name RI GHT and click Assign Attribute.
Click on 5 and assign the name FOOT.

-} Load Class Information =101 ]

This function assigns trial attributes [class information] from a given *mat or
ASCII-file to trials of your data. The class infarmation vectar must match the
rumber of tials!

— Selecta CLASS INFORMATION FILE:
Browse .. Import 'fizard

— Defing ATTRIBUTES:

Attribute Name: | 5 RIGHT =

Change name to: I FoaT|

Azsigh Attribute
Remaove Attribute

Help | cCancal | oK!

6. Close the window with OK. The attributes are assigned to your trials.

The assignment of attributes to the trials can be seen if you change tothe tri al x channel mode
in the section PRESENT in the Data Editor. As can be seen the session started with 3 foot movement
imageries. The first trial with a right motor imagery is trial number 4.
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tec',gB5analyze'testdata'BCI' sessionl.mat =] x|
File Header View Transform Pre-Processing Tools  Arkifack  Analyze Parameter Extraction Classification Options  Help  User

/18| 28] 2] |

cc3 CQC_J

BEGIH

T 500p
TRIGGER
FOOT

T:2 500p
TRIGGER
FOOT

T:3 500p
TRIGGER
FOOT

T:4 500p
TRIGGER

T:5  50.0p
TRIGGER
FOOT

T:6  500p
TRIGGER
FOOT

T:T S00p
TRIGGER

T3 500p
TRIGGER

T:9 500p
TRIGGER

TA0 5004
TRIGGER
FOOT

10 20 ;D 40 ;D ] ;o
ﬂil Fs [Hz]:l 128 time [s]:l g samples:l 1024 trials:l 160 channels:l 3 | -
‘ ¥ | Gotosecond [ 0.007812  Channel [ 1 Triak |_1_]
DISFLAY | FRESENT | SHOW |  MARKERS /ATTR. | EPOCHING | TOOLS | coMMenT | FILE |
[¥ Chan attr. [v Vert scale Select... IT * Free mode Select datal Analize .. I Mew I Save presets I

=
=i h hd

1 2 Channel positive scale 7| | W Trialat,. ¥ Hor. scal Rul I
:I Iannels I il nal atir. or. scale TRIGGER . r\. Multi chan, Liler Create plot
=i —I

10 Trials Zoom I'IDD | ¥ Sepaators I Grid

Select ... | Undol Autl Ma Am”ﬁ v Markers ¥ Ch. name Cancel | O MLt il Open journal |

g Seconds
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6. Identify Reactive Frequency Components

1. Select Spectrum of the Analyze menu

2. Select 1000 ms as Length of interval to analyze

3. Check Compute action spectra and compare to reference

4. Set Reference interval starts at to 500 ms and Action interval starts at to 6000 ms

5. Click on Select trials/chan. and exclude the channels with attribute TRI GGER from the
following calculation. Confirm the settings and close the window with OK.

6. Start the calculation with the Start button

-} Data Editor: C:\MATLAB6pS'gtectgBSanalyze' testdata),BCI session1l.mat &l x|
File Header View Transform Pre-Processing Tools Arkifact  Analyze Parameter_Extraction Classification Options Help  User
Dﬂ|n|§|@|@|‘“‘n” Data Quality

L

Average Chrl+8
Spectrum [ [

C2C

TA | p ERD - Event: Related Desynchronization  Crrl+E .
TRIGC i ' :
FOOT )} Spectr. - |EI X| b b b 1

TRIGC are analyzed a significance test iz applied to identify reactive frequency bands.

T2 Compute pawer spectra averaged over tials for specified intervals. If a reference interval and an action interval WMMWW”’%WW’M
FOOT

};:IG( — Specify INTERMAL(S):

FOOT Length of intervallz) to analyze: 1000 [ms] Refeience interval starts at 500 [rns]

T4 128 [samples] n B4 [samples]
TRIG{

TRIGC
FOOT ]
- — Specify type of DATAWINDOW:

TRIGC D ata window ype: Iboxcal 'l
FOOT

1Hee — Data DOWNSAMPLNG:

Action interval starts at: 6000 [ms]
T:5 ¥ Compute action spectra and compare to reference 3 [FGa [samples]

- [~ Reduce rumber of samples to limit frequency scale range Factor = 4
TRIG{

— Select TRIALS and CHANNELS:

T9 Select trials # chan.
TRIG{

< = e o
i it
}I:I%( Result procedure: ¥ Shaw with Fesult2D Automatic tieemaker is: lm e TRRLE v CURHEL RUIERS:
FOOT = Show with Fesult3D Floe ke || [ S et ity || e s Blobsde ek
| By E| E) Al =
55 [ Save results Filename: | enter flename « i
O
o Help | Cancel Start !
8 S SECUNUS [ [k Canne [ v RE Gl v Vel Soae eEst [T Wy T Fre
1 = Chanrels |posmve scale j ¥ Trialatt. [ Hor scale = | =l =
Mo = 1 [0 = [TriGGER [l | M | e et i et i e ki
w =1 Trials Zoom 100 =5 | W Separaters I Grd [0 oot [T s [T oadt [ chwosk | | (5 oual [T chowet | | [T ouof [T chowes
Select ... | Undo Autl Ma Am”Tpp ¥ Markeis [ Ch. name —Ica”CEI o Ship ot oy
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As can be seen the subject has a prominent rhythmic activity around 14 — 18 Hz over Cz which is
different for action and reference period. However, differences can also be observed in the alpha
band. The green line indicates the estimated power spectrum in the action interval and the blue line in
the reference interval. The magenta lines at the top of the graphs display the significance level. The
dotted lines represent the 95% significance levels for the power differences.

RS
File Edit Help
> |

Parameter:

Filename :

Mumber of trals : 160

Fetion intanval starts at sample © 768
Reference interval starts at sample : 64
Intervallength : 128 samples

Diata window type : boxcar

Powerspectrum {Pxx) with significance level

CHA CH2

Legend:
= Pxx of action interval

= Pxx of refarence interval

Significance
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Display: Presentation:
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7. ERD Analysis

1. Open ERD under the Analyze menu entry

2. Select a reference period of 500 to 1500 ms

-) ERD / ERS

=101x]

ERD / ERS [event-related d + ! d by changes of signal power
vertime (relative to vaues of a eference perod), To dezﬂgn Mereusatia “Design fikes” function

— Specify REFERENCE F'ERIOD

Stait of reference pesiod 2k ] nid of 1eference peiod & [rres]
[zamples] 132 [samples]

— SelectFILTER:
(% Mo fiter Design filer
name / typa / £fio) / Flhi) / ieal J order
— Specity COMFOME ?nalized:

(% Inducad componeniz onl [none phase lacked] " Raw signal induced and avoked components]

— SCALING of result:
Fesull scaing: | Relative power change %] 'I
— AVERAGING, SMOOTHING and STATISTICS:
Method |mean "I Facter: | 16

™ Smocthing: Ia-'-'aj ¥ w'mml 125 [ms]

[~ Usathe “Ervelope niethod"

[W¥ Horizontal averaging

Sigificance lest: | sign test .

[ Select TRIALS and CHANNELS:

Select hials / chan. ‘
Result procedure: [ Show with Resul2D Allomaic fresmaker i réj
[T Shio with ResuliaD |
™ Save iesuls Fiename: | wrier fiename _I
Help | Cancel | Start |

g.

GUGER
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x|

fiber characteriztic: the fiber curve iz displaped. The Save presets’ button in the Diata Edior allows to store the

created fikes,
3 Fitercrder e 50} [ 5 ]

Upper cutolf frequency [- 3 dbl: 18

. Creste highpass-, lowpass-, bandpass- and bandshop- fiters fos further analysis. Dependng on the speciied

— Specily FILTER DETAILS:

Filter lype: | bandpass [BF)

Fiker realizabon Bullclwcvlh

Lower cutolf frequency [- 3db) | 14 [He]
[8]

=TT T 1T ) T

T T

Predefined fllers:

Name: BETA

Help Cancel | Ok I

Click on Design filter and create a But t er wor t h filter with order 5 and a lower cutoff frequency
of 14 Hz and an upper cutoff frequency of 18 Hz. Assign the Name BETANEW press add to

list > and press button OK

Check Use filter and select BETANEW

Click on Select trials/chan. and exclude the TRI GGER channel. Include only the FOOT trials.

Close the window with OK

Press OK to perform the calculation

Repeat steps 5-6 and include only trials with the attribute RI GHT
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The figure below shows ERD/ERS calculated between 14 and 18 Hz for trials with attribute FOOT.

It can be seen that a very pronounced ERS can be observed over channel Cz. The blue graphs on top
of the figures display the significance level of the ERD/ERS changes. The solid line indicates the 95%

significance level.

Event Related Desynchronization / Synchronization

CH1 CH2

me ] tme ]

Channel 1, C3 Channel 2, Cz

The figure below shows ERD/ERS calculated between 14 and 18 Hz for trials with attribute RI GHT. It
can be seen that the subject shows an ERD over the contralateral area (C3) during the imagination of

the right hand movement.

Event Related Desynchronization } Synchronization

CHA CHZ2

tme ] me ]

Channel 1, C3 Channel 2, Cz

I

Parameter:
Filename :
Number of trals : &0
Aerage options : [mean 16 samples]
Filtername : BETA
Type : BR
Frequ.borders : [14 1]
Realization : butter
Order : &
Used signal © Induced componets
Reference interwal : [G4 192] samples

Legend:
= relgtive power change
w significance

= reference

i

Parameter:
Filename :
Mumber of tralz : 20
Furerage options : [mean 16 samples]
Fittemame : BETA
Type : BF
Frequ borders : [14 1]
Realization : butter
Order : &
Used signal : Induced componets
Reference irterval : [54 193] samples

Legend:
= relative power change
w significance

= reference
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8. Feature Extraction
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This function of the Parameter Extraction menu computes the band power within a certain frequency
range of the selected channels. The band power is estimated by digitally band pass filtering the data,
squaring and averaging over consecutive samples according to the window length.

Perform the following steps to calculate the band power:

1. Click on Bandpower under the Parameter Extraction menu to open the following window:

-} Bandpower

=101

. Calculate the bandpawer by bandpass filtering, squaring and averaging over a specific window of the data.

— Select CHANNELS:

Select channels |

— Specity METHOD and PARAMETERS: 2—.

Choose a filker for the estimation:

Specify averaging window:

IBETAJBP#MHBz’buttBIJS
name / tppe / Fllo] 4 F(hi) A real / oorder

[ms]

[samples]

Length: 1000
128

j Design new filter...

Overlap: | 992187 [ms]
n 127 [zamples]

 Add new channels

& Replace all channels

Result procedure:

Filename:

Automatic reemaker is. | enabled b

[~ Save result data I

enter flename

Help

Cancal ‘

Start !

4.

S

Sabeot charmel for further peocessing

EW

— Select CHANMNELS:

Clently availathe chiannels are e b sid
chanel name on the kY, Calouions ate sppled orlyon the selecled channels shown in lhe dght ksl

ivalatla charrel:
nurGer S name

Saleated charcwl:
rurber / neme:

5.

2ICz

<-Fieawave from fst I

[ Sekadi |
| cFemove sekgion |

Help | cancal | @Rl |

2. Select the created BETANEW f i | t er with the bandwidth of 14 to 18 Hz

3. Specify the length of the estimation interval as 128 samples with overlap of 127 samples.
Attention: No other overlap is allowed in the DEMO mode

4. Click on Select channels and add the EEG channels C3 and Cz to the list. Confirm the

settings with the OK button.

5. Press Start to calculate the parameters
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9. Data Set Classification

1. Select Feature Matrix from menu Classification

2. Set the classification interval to Start at 1000 ms, End at 8000 ms and Step to 500 ms
3. Select as Class1 Rl GHT and Class2 FOOT

4. Click on Select feature channels ... and select channels 1 and 2 for classification

5. SelectLi near Discrimnant Anal ysis (LDA) from the Classification method pull-down
menu

6. Press Start

=} Feature Matrix o ]

[3enerate a feature matriy az input for the classification methods. Select clazs allows to zelect thalz with a
certain attribute. Each attribute coresponds to a clazs. Select time point allows to select specific time points.
Each time point comrezponds to a clazs.

— opecify CLASSIFICATION INTERNAL:
Start at; 1000 [mz] Step: RO0 [rng] Stop at; 2000 [mz]

128 [zamples] E4 [zamples] 1024 | [zamples]

— Specify CLASS LABELS { TIME POIMNT:

{* Select clazs:  |ARTIFACT ;I " Select time point:
REMOWVE 1800
2200
RIGHT 2a00
3000
3500
4000

=l 4500 |

— Select FEATLIRE CHANMELS:

Select feature channels . |

— Choose METHOD and QOFTIOMNS:

Clazzification method: | Linear Dizcriminant &nalysiz [LDA] j

[~ Randomly permutate the matrix

Result procedure: [V Classify data Automnatic treemaker is: Im
[T Saveresults Filenarne: enter filenarme |

Help | Cancel | Start




medical & electrical engineering g .

GUGER
TECHNOLOGIES

The Linear Classifier window opens with the created feature matrix. The feature matrix contains 2
features (channels 1 and 2), with 160 examples and 15 time points (1000, 1500, ... 8000 ms).

1. Select under Classification method Li near Di scrim nant Anal ysis (LDA) and 10 x 10
cross-val i dati on to randomly mix the training and testing data.

2. Check Show with Result2D and Open classifier window

3. Press Start

) Linear Classifier o ]

Compute a clagsifier [weight wector] bebween groups of trialz marked by clazs labels [tial attibutez]. The
performance of the classifier can be estimated by crozz-validation. The weight vector can be viewed, edited
and ztored for real-time proceszing with g. R T sps.

— Load FEATLIRE MATRI=:
M arne of feature matrix file: I Browse ..
Dimenzian; I 2 16015 [features « trials » time paointz]

— Select FEATLIRE CHANMELS:

b ap feature no.: I 1 againzt; I 2

— Choose METHOD and QOFTIOMNS:

Clazzification method: ILinear Digcriminant Analysis [LOA] j betric: £ kahalanobiz distance
Training / test-zets: I'IEI # 10 crogs-validation j " Euclidian distance
Result procedure:  [¥ Show with Result2D Autornatic: treermaker is: Ienabled vI
¥ Open clazsifier window
[T Saveresults Filenarne: enter filenarme |

Help | Cancel | Start
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The classification results for RIGHT and FOOT movement imagery are given in the graph below. At
the beginning of the trial the error is around 50%. After second 5 (arrow is show on the screen at
second 3) the error drops down. The best error of about 16 % can be found at second 7 of the trial.
This means that the data set can be classified with an accuracy of about 84 %.

ol
File Edit Settings Tools Help
. A >
Classification Error —I
[%] Parameter:
5 1 (Total Error) Class: FOOT
I Class: RIGHT

Interval:

128 64 1024 samples
hethod: LOA
Train/Testdata: CW
Trials per class: 80 20

Legend:
= Emor

time [s]

< 14 |

Display channels: Display: Presentation:

I i | | - ; v Title s
1 yBlecksze Show] Al e sty [ Cremeinme |l B Assign I &rrangement | _ines £ Colors I Scales ... I
j V¥ Hariz. seale W Channel number M Y-grid ¥ Legend

I 1 jBIock Select... | I Zscale [ Golabar ¥ Ane Select,.. I | Compary [C Size / Prop. .| Fonts.. | Backgound .|

v Parameter

To further improve the classification result calculate also the bandpower in the alpha range of the
EEG. Identify the optimal frequency range from the ERD analysis results.
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